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About this guide

Welcome to the MiniJam™ experience. This guide is designed to help you use your MiniJam to its fullest extent. It
describes all you need to know about using your MiniJam and the applications that come with it...

/
ﬂ ’%—- This icon denotes a Hot Tip. Be sure to check out the Hot Tips!
A\

Introducing the MiniJam

Now you can instantly turn your Handspring™ Visor™ into an MP3 Player. Use the easy drag-and-drop MP3 file
transfer application to transfer MP3 files from your desktop to the MiniJam™ and listen to CD-quality sound on
your Visor™ handheld.

With the MiniJam you can read eBooks on your Visor handheld. You can even view images. So grab your MiniJam
and Visor handheld and get ready to jam!

System requirements

To transfer MP3 files and listen to them on your MiniJam, you will need the following:
= Handspring™ Visor™ with USB HotSync cradle

= Windows System Requirements:
- IBM Compatible 486 PC or higher
- Windows 98 or Windows 2000
- 8 MB of RAM minimum (16 MB recommended)
- USB port on Notebook or Desktop PC
- 30 MB available hard drive space
- CD-ROM drive

=  Macintosh System Requirements:
- Apple Macintosh or compatible computer with a PowerPC processor
- Mac0OS 9.0
- USB port
- 30 MB available hard drive space
- CD-ROM drive

Setup

Inserting MMC Cards
The MiniJam has two MMC card slots, Slot A, and Slot B.

MMC
<~ B

MMC
A

Fig. 1

You can use 8, 16, 32, or 64 MB MMC cards in the either or both of the slots.
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Inserting the MiniJam

/
ﬂ ’5-- It is a good idea to start with fresh batteries in your Visor Handheld before installing the MiniJam.
\

Remove the protective cover from the Springboard™ slot and plug the MiniJam into your Visor handheld until you
hear two beeps (try not to press the buttons during installation).

When you have properly inserted the MiniJam, the LaunchPad™ will be displayed. From here you can play MP3
files, look at pictures, or read eBooks.

To return to LaunchPad, simply run it from your Applications Launcher by tapping on the LaunchPad icon. m

Attaching Headphones

Plug the Earbuds into the Headphone jack. There is an icon which looks like a pair of headphones. (See Figure 3
below).
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Using the hardware buttons

These are the features the hardware buttons on the top of your MiniJam perform.

LED

Volume DOWN Volume UP

Auxillary DC In Headphone Jack

Sound Control MiniJam Control

Previous/Rewind Next/Fast Forward

Play/Pause/Stop
Fig. 3
Button Press Press and hold
Play/Pause/Stop Press once to play. Press again to pause. Stop playback.
Next/Fast forward | Skip to the next MP3 track. Fast forward within an MP3 track.
Previous/Rewind | Skip to the previous MP3 track. Rewind within an MP3 track.
Volume up Increase the volume by one step. Continuously increase the volume.
Volume down Decrease the volume by one step. Continuously decrease the volume.
MiniJam control Display MiniJukeBox. Place the MiniJam in Sleep mode and
disables the buttons (Key Guard).
Sound control Cycle through Sound Control settings (“Rock, | Mute.
“Pop”, “Classic”, “Dance”, User 1-4).
Item Function
LED The LED flashes red during the formatting of MMC
cards
Auxiliary DC In The MiniJam can run off auxiliary DC power. See
“Technical Specifications” for exact details.
Headphone Jack Accepts standard 3.5mm stereo mini-phono plug.
L To extend the life of your Visor batteries, always use the MiniJam control button (press and hold) to put the
ﬂ ’—-» MiniJam in sleep mode when not in use. This also will disable the buttons so they are not accidentally
™ pressed. To “wake up” MiniJam from sleep mode, just tap the MiniJukeBox icon and then use the onscreen

play function (the play button on the skin or from the menu).
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Using MiniJukeBox™

To run MiniJukeBox, tap on the MiniJukeBox icon on your Handspring Visor or you can tap the MiniJam control
button on the MiniJam control panel (quick launch back to MiniJukeBox from other Visor applications or even
when the Visor handheld is turned off).

r'c,
Playback Controls
When MiniJukeBox is launched the main screen is displayed.

hliniJukeBox

InnoGear = Intro

Fig. 4

This icon, ¥, indicates that auxiliary DC power is present.

The ™ icon brings up a menu where you can display the Playlist, File manager, Sound control, Song info, Skins,
and launch the File transfer application (MiniLoader).

Because of the variable nature of skins, the main screen can have all, some, or none of the following functionality:

= Song title display

=  Song time display

=  Song position indicator

= Volume slider

= Previous track, Rewind, Play/Stop, Fast forward, and Next track buttons
= Left/right balance

= Shuffle, Repeat, Mute toggle buttons

Regardless of what controls are used in a skin, you can always access the basic control functions by going to the
Playback menu. To access the menu, tap on the menu icon.
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Volume control and mute can be accessed on the View menu.

Flayback Help |

Volume V|
S5ound w0
Plavlist L i
Files «F
Songinfo 1 [[1R1]1]
| 2kins K| —

Fig. S

Play
Pause .-""LI
Stop .
Previous - -

Mext

Fig. 6

Managing Your Playlist

To view the playlist screen, select Playlist from the View menu. The lal or [ indicates whether an MP3 is on the
MMC on slot A or slot B. Tap the play button to skip the selected MP3. Tap the Done button to return to the main
screen.

MiniJamn: Playlist
1. Innoi3ear - Intro A
2. Marillion - Rich
3. D Marz - Lake Futan
o, Eddie Harris - Listen Hera
C. Eric Burdon - House OF The Rifg)
6. Joe Strumrier And The Mezcdg)
7. Millencolin - Mo Cigar
2. Pucho and His Latin Soul Broth)
9. The Damage Manual - Sunsetg]
10. The Get Up Kids - Red Letter [{ 4

Fernove] [ Up Jiown) (Flay )
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Changing Skins

To select a different skin, select Skins from the View menu. Select one of the listed skins and then tap the Select
button. Check “Set as default” if you want that skin to be your default skin.

MiniJukeBox

Andre's Steran
Muzichatch

Cancel

Fig. 8

To beam the skin to another Visor handheld, select a skin and tap the Beam button.

Sound control

On this screen you can change the boost bass and/or treble by adjusting the sliders. To select one of the four presets
(Rock, Pop, Classic, Dance) tap the button marked with the desired setting. You can save your own settings to any
of the eight buttons by tapping on the Assign button. To rename any of the buttons, tap the Rename button.

hliniJukeBox
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Preferences

The sleep timeout is the length of time before the MiniJam automatically places itself in sleep mode. Power
consumption is significantly reduced in sleep mode. The timeout options are 1 Minute, 5 Minutes, 15 Minutes, 30
Minutes, and 1 Hour.

MiniJukeBox

InnoGear = Intro

Minilam: Preferences

S5leap timneout: + 15 Minutes

' Show song numbersz in plavlists
' Show MM indicator in plaxvlists

Fig. 10

Custom hardware button mapping

To display the Button preferences screen, tap the Buttons button on the MiniJam Preferences screen.

After making the desired changes to the button mappings, tap the OK button to save your changes and return to the
main screen. To exit without saving changes, tap the Cancel button.

Minilam: Button preferances
Btn. Press Hold
# * MiniJukeBoxw Sleep

44  Previous w Rewind
M| ™ Flav/FPause w Stop

pp T Mext w Forward
4 = \allp w \alUp
- wMaolDown o Mol Down

m T EQpreset W Mute

Cancel

Fig. 11
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Uploading MP3 files to Your MiniJam

To upload MP3 files to your MiniJam:

1. Your Handspring Visor should be properly seated in its cradle. See the Handspring User Guide if you do
not know how to do this.

®

2. First, run MiniLoader on your Handspring Visor.

3. Then, on the PC you can use MJLoader, MusicMatch, or any other third party that supports file transfer
from the desktop to the MiniJam. On the Mac, use MiniJam Browser.

MiniLoader

Setting up for uploading

When MiniLoader is run, it automatically waits for a connection

Formatting MMC'’s

MiniLoader is also the application to use if you need to format MMC cards. MMC cards from InnoGear are
preformatted. If you acquire MMC cards from other sources, you will need to format them before uploading music
to them.

If there is an unformatted MMC card in either of the slots, as soon as MiniLoader is run, it will automatically inform
you that the card is not correctly formatted and ask if you want to format the card.

If you would like to reformat a card, tap the screen-printed menu icon to bring up the menu. Select “Format MMC”
from the Options menu. Tap the Format button of the card you would like to reformat.

MusicMatch

To install MusicMatch, double-click the installer icon in [Your CD drive]:\[Mac or PC]\MusicMatch. The
MusicMatch application will be installed, including the MiniJam plug-in. Once you have the MusicMatch Jukebox
installed, you can access help from the Help menu.

Note: The MiniJam plug in for MusicMatch Jukebox for MacOS will be available soon. In the meantime, you can
still use MusicMatch to create and listen to MP3 files.

MJLoader

If the MJLoader is not already installed, install it by going to [your CD drive]:\MiniJam\PC\MJLoader and double-
clicking Setup.exe.

Once MJLoader is installed:

1.  Run MJLoader (Start->Programs->MiniJam->MJLoader).
Add MP3 files by either:
*  Dragging the MP3 (or multiple MP3 files) into either of the card slot areas
= Right clicking on a card slot area and selecting “Add files...”Select one more MP3s and then click the
Open button.
= Selecting “Add files...” from the Edit menu. Select one more MP3 files and then click the Open
button.
3. Select “Commit” from the file menu.
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MiniJam Browser

If the MinJam Browser is not already installed, install it by going to [your CD drive]:\MiniJam\Mac\MJLoader and
double-clicking MiniJam Browser (1.0b13).sea.

You need to disable the HotSync manager while using MiniJam Browser. To do this, click the HotSync icon in the
upper-right hand corner of your screen and select “HotSync, Setup”. On the HotSync Software Setup screen, click
the “Disabled” radio button.

Double-click the MiniJam Browser icon to launch the application. To transfer MP3 files to the MiniJam simply drag
one or more MP3’s into the appropriate card window. Transfer of the files will begin automatically.

L There are literally thousands of free (and legal) MP3 music and spoken word tracks that you can
ﬂ ’—-» download from the Internet. Check out any of these popular sites...just to name a few!
™ www.emusic.com
www.mp3.com

www.mp3lit.com
www.listen.com
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Using the MiniJam’s Flash memory

The MiniJam comes with 2MB of flash memory. You can use FileMover to move applications and data to the flash.

Third Party Software
ClubPhoto

Documentation for the AlbumToGo software from ClubPhoto can be found in [your CD drive]:\[PC or
Mac]\ClubPhoto. To get detailed information, future product updates, customer and technical support please go to
www.clubphoto.com.

Peanutpress.com

Documentation for PeanutReader from peanutpress.com can be found in [your CD drive]:\PalmOS\Peanutpress. To
get detailed information, future product updates, customer and technical support please go to www.peanutpress.com.
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Battery information

Since the MiniJam does not contain batteries, it draws its power from the Visor handheld batteries. Because of that,
the amount of playback time is highly dependent on how you use your Visor handheld. The MiniJam’s built-in
power management features automatically shuts off sections of the unit to conserve power. With additional care,
you can maximize your battery life.

If you have just installed new high quality batteries in your Visor handheld and start playing music from your
MiniJam, you may experience about 5 hours of continuous playback time. On the other hand, if you’re running a
high-speed application, such as games, while playing music and the backlighting is on, then the playback time may
be reduced to 2 or 3 hours.

Another method for maximizing your playback time is to record your MP3 tracks from your CDs at a lower “sample
rate”. The Music Match software included on the CD you received with your MiniJam, includes this feature. For
example, you could nearly double your playback time by saving your music tracks at 64Kbs sample rate. One other
benefit of recoding your tracks at the lower sample rate is smaller file size. In other words, you could store up to 2
hours of music on one 64MB card.

The battery indicator on the Visor handheld’s idle screen only represents the voltage of the batteries and not the true
capacity of the battery. Therefore, for optimum use of your batteries and the MiniJam, do not replace them until the
“low battery” warning message has appeared on your Visor handheld’s screen.

Software Updates and Future Features

= A program for creating your own skins will soon be available for download from http://www.innogear.com.
= InnoGear is working with third party developers to allow storing of other Palm programs and database files on
the MMC and we plan to integrate this into File Mover.
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Technical Q&A

General

1.  What are the system requirements for the MiniJam?
Handspring™ Visor™ with USB HotSync cradle

Windows System Requirements:

= IBM Compatible 486 PC or higher

= Windows 98 or Windows 2000

= 8 MB of RAM minimum (16 MB recommended)
= USB port on Notebook or Desktop PC

= 30 MB available hard drive space

= CD-ROM drive

Macintosh System Requirements:

= Apple Macintosh or compatible computer with a PowerPC processor
=  MacOS 9.0

=  USB port

= 30 MB available hard drive space

=  CD-ROM drive

2. Can I transfer files to the MiniJam using a serial cradle/connection?
= Serial connections are not supported by the MiniJam software, since a serial connection would be
prohibitively slow. Look into a low cost USB upgrade for your computer, and then use it with the
Handspring USB cradle.

3. Any suggestions on how to increase the transfer speed to the MiniJam?
*  The transfer speed via the USB cradle is limited by the Visor to MiniJam connection and the access
speed to the MMC cards.
= The SpeedLoader USB MMC card writer will available soon and will have much faster transfer
speeds. Please watch for this on www.innogear.com.

4. How can I increase the battery life while using the MiniJam?
= In general, MP3 players require additional power. They typically range between 5 and 10 hours of
battery life. You can expect 5 to 7 hours of continuous playback time from the MiniJam.
= The battery indicator on the Visor handheld’s idle screen only represents the voltage of the batteries
and not the true capacity of the battery. Therefore, for optimum use of your batteries and the MiniJam,
do not replace them until the “low battery” warning message has appeared on your Visor handheld’s
screen.

Here are some add-on power options that InnoGear will have these available in the near future:

= an AC wall adapter and a car power adapter

*  PowerPak Extended Playtime battery pack - This small battery box holds 4 AA batteries and powers
the MiniJam directly through the top DC jack of the MiniJam or the Visor cradle connector by using a
modular cable that allows you to use either end. The PowerPak is expected to give you around 15
hours of play.
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Until then, you can use any AC adapter which is rated:

= Input: 120V, 60Hz

= Qutput: DC 6VDC, 300mA,

= Center/Tip: +

= Outer/Ring: -

= 2.35mm plug (2.33mm will also work)

MiniJam Related Questions

1. Nothing happens when I press the hardware buttons.
= After a user-definable period of time (15 minutes by default), the MiniJam goes into sleep mode. This
is to conserve battery life. While in sleep mode, the hardware is disabled (no power draw). The
MiniJam can also be placed in sleep mode by pressing and holding the MiniJam control button (the
button that has an indented circle on it). To “wake” the MiniJam, launch MiniJukeBox, and then use
the onscreen play function (the play button on the skin or from the menu).

2. Ipurchased an 64MB MMC card and it show only 32MB’s of capacity.
= Our MMC cards are preformatted in our proprietary file format. Some 64 MB MMC cards were

incorrectly formatted as 32MB cards. Simply reformat your MMC card to recover full usage of the
MMC.

3. MiniJukeBox crashes when I try to scroll a list (e.g. playlist, skins list, file manager)
*  MiniJukeBox conflicts with MenuHack. If you have MenuHack running, please disable it from your
Visor handheld.

PC Related Questions

1. Tlaunched MJLoader and it says, “disconnected”.
= Check that Visor handheld is properly seated in its cradle and that your USB cable is connected to your
PC.
= Check to insure that Handspring HotSync manager installed. MJLoader needs the libraries that are
installed by Handspring.
*  Check to make sure the Visor is turned on and MiniLoader is running on your Handspring Visor. If
not, tap the MiniLoader icon from the Application launcher.

2. When trying to download playlist to the MiniJam, I get a Microsoft “Visual C++” error message.
=  MlJLoader and MusicMatch Jukebox’s MiniJam plug-in cannot both be running at the same time.

Mac Related Questions

1.  When I run MiniJam Browser, I get the message “Handheld is disconnected”.
= Check that the Visor handheld is properly seated in its cradle and that your USB cable is connected to
your Mac.
= Check to insure that Handspring HotSync manager installed but disabled. MiniJam Browser needs the
libraries that are installed by Handspring.
=  Make sure the Visor is turned on and that MiniLoader is running on your Handspring Visor. If not, tap
the MiniLoader icon from the Application launcher.

2. When I run MiniJam Browser, I get the message “Visor port in use. Try disabling HotSync.”
*  You need to disable the HotSync manager while using MiniJam Browser. To do this, click the
HotSync icon in the upper-right hand corner of your screen and select “HotSync, Setup”. On the
HotSync Software Setup screen, click the “Disabled” radio button.
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Technical Specifications

Key Features
e  Plug and Play, skip-free, CD-quality MP3 player for the Springboard™ expansion slot.
e  Compact, portable size and very light weight.
e Two MB flash memory for storing MiniJam software and other Palm OS applications and database files.
e Two external memory slots that provide up to 128 MB of storage memory using 2 removable 64 MB

MultiMedia Cards (MMC).
e  Conveniently placed top mounted control panel with multifunction, user-definable buttons to operate the
MiniJam when using the Visor™ handheld while in another application or when turned off.
e High quality “earbud” style earphones.
e Soft belt pouch to hold your Visor handheld and the MiniJam with open top to access the control keys.
e  Auxiliary DC-in jack for use with optional power accessories for extended play (power accessories not
included and not required to use the MiniJam)
e  MiniJam Software Suite includes:
o  MiniJukebox™ MP3 program for playback and playlist organization.
o Additional “Skins” for MiniJukeBox (changes the look and feel of the user interface)
o MiniLoader™ for direct USB file transfer from the desktop software.
o MJLoader™ for both Windows and Mac OS computers allowing you to easily drag and drop MP3
files from your computer to the MiniJam.
o LaunchPad™ for simple, one tap navigation (upon installing MiniJam) providing you quick access
to MP3 files, images, and eBooks.
o File Mover for moving files to and from the MiniJam to the Visor handheld.
e  MusicMatch Plus™ (full registered version) for the PC and Mac which includes many features to create
MP3 files, organize playlists, and directly download to the MiniJam.
e  Sample music and other content from EMusic and other MiniJam content partners and providers.
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Specifications

e  MP3 Digital Audio Decoding:
o MPEG 1,2 Layers 1,2, 3
o MPEG 2.5 Variable Bitrate 32-320kbps
e Dimensions (W x H x D): 54 x 65 x 29 mm
o Weight: <40 g
Expansion Memory for the Handspring™ Visor ™: 2 Megabyte Flash for storing all MiniJam applications
and for storing additional applications and database files for the Handspring Visor.
Outer Case: ABS Plastic (Graphite color) - Polycarbonate (Ice color).
Signal-to-Noise Ratio: > (90) dB into 32 Ohms.
Frequency: 20Hz-22KHz
Maximum Output: SmW into 32 Ohms
Harmonic Distortion: 0.05% at ImW output
Power: MiniJam uses the Handspring™ Visor ™ batteries or auxiliary DC-IN.
Battery Life: 5 hours average (depending on usage).
External Power Jack (DC-IN): 6VDC (center contact is positive).
Slots: Two Multimedia Card slots (MMC).
User definable control panel buttons for MP3 playback control and sound settings. The buttons are
multifunctional. (see “Using the hardware buttons” in this manual for more details). The default settings
are:

Play/Pause/Stop
Next/Fast forward
Previous/Rewind
Volume up
Volume down
MiniJam control
Sound control
e  MP3 Playback features:
o Random play
o Repeat play
o Selective playlist management
o Sound Control settings: Rock, Pop, Classical, Dance and four user definable settings.
e  User Interface
o 160 x 160 LCD with backlight (Handspring Visor)
Auto-scrolling of long title names.
ID3 tag information
User selectable and beamable “Skins”
Full playlist view with additional mapping of the up, down, and To-Do keys on the Handspring
Visor.
e Power Management
o Auto shutdown with user definable time settings (Sleep timeout) from 1 minute to 1 hour
o Immediate shutdown by pressing and holding down the MiniJam Control button.

O O O O O O O

O O O O

Rev. 1.11 Page 17 of 19



¢k

MiniJam User Guide muEmggam

Agency Approvals

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) This device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may cause
undesired operation.

NOTE: This equipment has been tested and found to comply with the limits for a Class B
digital device , pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation.
This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference to
radio communications. However, there is no guarantee that interference will not occur in
a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try and correct the interference by one or more of the following
measures: Reorient or locate the receiving antenna. Increase the separation between the
equipment and receiver. Connect the equipment into an outlet on a circuit different from
that to which the receiver is connected. Consult the dealer or an experienced radio/TV
technician for help.
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Customer and Technical Support

For customer and technical support:
Phone: 1-877-711-6778

Customer support email: info@innogear.com

Technical support email: support@innogear.com

Rev. 1.11
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